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Jun 24, 2021+ Proven solutions Three decades after Microsoft PowerPoint was initially released in May 1990, this presentation software has become a symbol of professionalism and excellence. However, there are quite a few downsides to traditional PPT files, PowerPoint produces because the contents of your presentations can be easily modified and
used by someone else. The 2010 and later versions of PowerPoint have addressed this issue by including the Save to Video option that enabled users to create video files which can be easily posted on social media, video sharing platforms or used in eLearning courses. The built-in PPT file conversion option featured in recent versions of PowerPoint
has certain limitations that prevent you from choosing the video file format or including inserted media files in the PowerPoint presentation video. That's the reason why we've gathered 10 best PPT to video converters that make the process of producing a video from a PowerPoint presentation easy and fun. The All-in-One Screen Recorder & Video
Editor Record desktop screen, voiceover, and webcam simultaneously Edit recorded clips quickly with a wide range of professional tools Built-in plentiful templates and effects Export to MP4, MOV, MKV, GIF and multiple formats Tips for Choosing PPT to Video Converter Software Investing your money wisely is always a good idea because the most
expensive solution is often not the best solution. The same is true for PPT to Video converter software, so before you go ahead and choose the program you will be using to convert your PowerPoint presentations into videos here are a few tips that will help you make up your mind. Checking the amount of video file formats supported by the software is
the key step towards selecting the right converter because it will give you the versatility the PowerPoint's built-in PPT to video converter lacks. What's more, some of the programs for PPT to video file conversions don't allow you to convert audio files or animations into videos, which can ruin the original presentation, so prior to buying a software
make sure that it can turn multimedia files into videos as well. Last, but certainly not the least, try to determine whether or not the software is cost-effective because there is absolutely no point in spending a lot of money on a software that has the same PPT to video file conversion capabilities as PowerPoint. 10 Best PPT to Video Converters Price:
Free Trials, Plans start at $49.95 Compatibility: Windows XP or later Regardless of how complex your PowerPoint presentation is, the Wondershare's PPT to Video converter guarantees that each file conversion you make goes smoothly. The software offers support for a wide range of video file formats, including MOV, MP4 and AVI file formats. Its
users can also convert their PowerPoint presentations into HD videos, while batch conversion of up to 12 PPT files is also on the list of options Wondershare's PPT2Video Pro provides. The software lets you adjust the video settings and select the video resolution, frame rate or adjust the duration of each slide in the presentation before the conversion
process begins. The Wondershare PPT2Video Pro enables you to share your videos to Facebook or YouTube directly from the software, immediately after the conversion process is complete. Pros: Cost-effective Offers support for all most popular video file formats Cons: Only works with files created in PowerPoint 2010 or older Batch conversions
limited to 12 PPT files Price: $44.95 Compatibility: Windows 10 or older This PPT to Video Converter can help you turn PowerPoint presentations in PPT, PPTX, PPTM, POT or POTX file formats into nearly all popular video file formats. The software is compatible with 64 and 32-bit versions of PowerPoint and it can be used with all versions of
PowerPoint released from 2000 up until 2016. The video files you produce using the Leawo PPT to Video Pro can be played on Android and iPhone Smartphones, tablets, gaming consoles as well as Apple TV or Pocket PC devices. Your PowerPoint presentations can be converted into HD video file formats, and the software lets you include narration
and all other audio files into the output videos. You can share the videos on Dailymotion, Vimeo, YouTube or Metacafe websites Pros: Unlimited batch conversion Lets you add logos and watermarks to converted videos Cons: Not compatible with the Mac OS Demanding system requirements Price: $97 for a single lifetime license Compatibility:
Windows Vista or later iSpring River is basically a PowerPoint add-on that can be accessed from the software's ribbon once it installed on your computer. The fact that this is not a stand-alone computer program doesn't diminish its capabilities one bit since iSpring River lets you convert PPT files into highly compatible video file formats such as MP4
or AVI. Furthermore, the add-on allows you to adjust the video settings before each file conversion, so you can select the size of the video and video compression values. All animations or audio files included in the original PowerPoint presentation will be included in the output video as well as transitions or font and text formatting. iSpring River
enables you to export your videos directly to YouTube, but it doesn't offer support for file sharing on other social media platforms. Pros: Efficient and easy to use Lets you publish videos to YouTube without saving them on a hard drive Cons: Doesn't work as a stand-alone software No HD video support Price: Free version available, Pricing starts at
$29.99 Compatibility: Windows XP or later All PPT files created with 2013 or older versions of PowerPoint can be easily converted to videos using this powerful converter. Besides enabling you to turn your PowerPoint presentations into HD video files that can be easily shared online, RZ PowerPoint Converter also lets you produce files that can be
burned to a DVD disc. Videos created with this software can be played on any modern video playback device and their quality is so good that you can even play them on large LCD screens. Even though the free version of this PPT to Video converter is available it lacks all features that make this software a great option for all professionals who produce
PowerPoint presentations regularly. If you choose to obtain the paid version of this Windows-based application, all multi-media you include in your presentations will be converted to video without loss of quality. Pros: Let you burn videos to DVDs Supports all PowerPoint file formats Cons: The free version of the software offers only basic PPT to video
file conversion options No batch file conversion option Price: Free trial available, $249 for a single user license Compatibility: Windows 7 SP1 or later, Mac 10.10 or later Camtasia Studio is much more than just a simple PPT to Video converter. This video editing software offers a free trial version that lets you turn PowerPoint presentations into high-
quality videos without leaving a watermark. Its a great option if you are looking for a quick way to convert a few presentations for free, and if you need a software that allows you to turn PowerPoint documents into videos then you should consider buying the single user license for Camtasia Studio. The paid version of the software enables you to select
which slides from a PowerPoint presentation you want to include in your video, add multimedia files or even incorporate webcam footage into the final video. Camtasia Studio enables you to export your videos in virtually any video file format and share them effortlessly to social media. Pros: Adding transitions, callouts or text effects is easy with
Camtasia Studio Provides access to advanced video editing tools Cons: The free trial lasts for just 30 days Expensive Price: $29.95 Compatibility: Windows 10 or older If you are looking for a reliable tool that lets you convert PowerPoint presentations into videos, then this converter is the right choice for you. Movavi PPT to Video Converter lets you
optimize your videos for viewing on mobile devices which makes it particularly useful if you want to extend the reach of your videos. You can convert all PowerPoint files created with the 2013 or older versions of the software, and save them in AVI, MOV, MP4 video file formats as well as HTML5 formats such as WebM or OGV. Adding narration or
background music to the videos you convert is also on the list of options Movavi PPT to Video Converter provides so you can easily create tutorials or any other type of educational videos. Pros: Affordable Enables you to embed PowerPoint presentations on blogs and websites Cons: You can convert only one presentation at the time Not perfectly suited
for professional use Price: $49.95 Compatibility: WindowsXP or later This software provides a quick way to convert your PowerPoint presentations into videos, but it fails to offer much else. Shine PPT to Video Converter lets you save your videos in AVI, MPEG, FLV, MP4 or MOV file formats, but it doesn't allow you to produce HD videos. Furthermore,
its audio support is underwhelming, since adding voiceovers or creating soundtracks isn't something you can do with this PPT to Video file converter. The free version of the software is only available for a limited period of time, which makes it a poor option if you need to convert PowerPresentations into videos on a constant basis. Processing multiple
PowerPoint presentations at the same time is not possible with Shine PPT to Video Converter. Pros: Easy to use Supports all popular video file formats Cons: Not cost-effective Terrible file sharing capabilities Price: Free version available, Plans start at $41.97 Compatibility: Windows XP (SP2) or later This PowerPoint to Video converter has all the
features you'll ever need to turn your presentations into HD videos in only a few simple clicks. The software offers support for all PowerPoint file formats and it allows you to turn each presentation into a high-quality video. Xilisoft's converter lets you adjust the frame rates, resolution or video quality before each file conversion and allows you to
record narration before you start converting the document. After the process is complete, all audio files or animations you added to the original presentation will remain unaltered. The software doesn't have demanding system requirements, and it can work on Windows XP SP 2 or Windows 10 equally effectively. Pros: Lets you turn PowerPoint
presentations into HD videos Adding watermarks or logos to protect the privacy of your videos Cons: No batch conversion option No file sharing options Price: $49.95, Free trial available Compatibility: Windows XP or later You can easily convert all documents created with versions of PowerPoint up to 2013 as well as PowerPoint viewer using this
remarkably powerful software. This Windows-based application lets you convert your presentations to any popular file format such as MP4, WMV or AVI to mention a few and it enables you to keep all the sound files, transitions or animations included in the presentation you are converting. Moyea PowerPoint to Video converter provides complete
control over the video settings so you can adjust the frame rates or output video quality to match your project's needs. Adding logos, watermarks, music or voiceovers to your PowerPoint videos is a simple task with this PPT to Video converter. Pros: Powerful file conversion options Batch conversion is supported Cons: No HD output options Must have
PowerPoint installed in order to convert presentations Price: Free Compatibility: Web-based This simple and free online tool enables you to convert audio, video or image files as well as documents. The process of converting a PowerPoint presentation using the Online-Convert platform is straightforward since you only have to select the Video
Converter option from the menu and upload the file you want to convert. The platform then converts the file you uploaded and it saves it to your hard drive automatically when the conversion is completed. Even though the Online-Convert platform lets you adjust the basic video settings, like frame rates, audio quality or the size of the screen it lacks
more advanced PPT file conversion options. Pros: Free and easy to use Can be used to convert other types of documents and multimedia files. Cons: No file sharing options Limited video output formats Here is a list of 5 best free PPT to JPG converter software for Windows. These PPT (PowerPoint) to JPEG converter software let you convert
PowerPoint Presentations into JPG format easily. All these software are available free to download for your Windows PC. Apart from converting PPT (or PPTX) to JPG, some of these also let you convert PowerPoint slides to other common image formats, such as: BMP, GIF, PNG, TIF, RLE, RAS, EMF etc. My Favorite PPT to JPG Converter: Out of these
5 converters, the one that I like most is Free office Document To Image Converter. Apart from converting to JPG, it supports output to many other common image formats as well. You can also try these best free PowerPoint Viewer, PowerPoint to Flash, and PowerPoint to PDF Converter software. Here are the Best Free PPTX To JPG Converter
Software for Windows: Free office Document To Image Converter Free Office Document To Image Converter is a free software which lets you convert Office documents including PowerPoint files into JPG images easily. When you run the program, it first checks for running instance of Office program and asks you to close it or it closes it when you
click OK button. To convert a PPT or PPTX to image, click “Add File” button to select a file by browsing. Now click JPG from “Output File Type” from Image tab; select the output Save Folder and click Convert button to start the process. You can set the output folder of your choice too. All the slides of your PowerPoint file will be saved as separate JPG
files in the output folder. It has a limited functionality in the free version. When exiting this program, it asks you to register but you can ignore this message by clicking Close button. Other supported output formats are: BMP, GIF, TIF, TGA, RLE, PNG, EMF, and WMF. You can also set the output filename pattern according to your choice. If you check
“Show output folder when done”, it will open the output folder for you. By default it saves the converted images in “C:\Output Files” folder. Convert Document to Image Convert Document to Image is a free and easy to use program which lets you convert office documents, including PowerPoint Presentations into various types of common image
formats. You can convert PowerPoint files (PPT, PPTX, or PPTM) into JPG by using it. Load the program and click “Add Files” button to select input file, select the output format as JPG from the “Output Type” tab. Now change the output directory or leave the default as is. Finally click Convert button to start the process. Every slide will be saved into
the output folder separately as a JPG image. Various other supported output image formats are: JPEG, BMP, GIF, TIF, TGA, RLE, PNG, EMF, WMF, and PSD. Other input supported formats are: DOC, DOCX, DOCM, XLS, XLSX, XLSM, RTF, and TXT. Free PowerPoint-PPT to Image Jpg-Jpeg Bmp Tiff Png Converter Free PowerPoint-PPT to Image Jpg-
Jpeg Bmp Tiff Png Converter is an easy to use freeware for converting PowerPoint files to JPEG or other common image formats. When you run this free converter, it shows a dialog box asking to choose the version of the program (Free or Share). You can click “Free version” and click OK to start it. Now to convert a PowerPoint file into Image(s), you
can click “Choose File” from File menu to select your input file. Supported input formats are: PPT, PPTX, and PPTM. Now at Output Format tab, choose JPG as output. Select the Output Path and finally click Convert button. All the converted JPG files will be saved in the selected output folder. Other supported output picture formats are: BMP, GIF,
TIF, TGA, RLE, PNG, EMF, and WMF. You can also check/uncheck the “Open output folder when finished” button as per your need. You can convert only one file at a time in the free version. Other functionalities are also disabled in the free version. The program interface language can be switched between English (Simplified) and Chinese
(Simplified) from Options menu. It asks you to register the program when exiting. Libre Office Impress Libre Office is a versatile Office Suite and has various useful set of programs. Its Libre Office Impress is a free presentation software, and also has a feature of converting PowerPoint files into JPG images and is an alternative to MS PowerPoint. You
can use it for converting your PowerPoint file into JPG (or in other supported image formats) easily. Just open the PowerPoint (PPT, PPTX etc.) file with it and click Export from File menu. Now from the “Save as type” choose JPEG, type the name and click Save button to save the current slide as JPG file. There is no batch method to convert the
complete file in one go, so you have to go to the slide first and then follow the same procedure sated above. Other output image formats are: BMP, EMF, GIF, PNG, TIF, RAS etc. You can check or uncheck “Automatic filename extension” button if required. Overall this is a nice program which lets you convert PowerPoint slides into JPG images, but one
slide at a time. This conversion feature is also available in other Free Office Suites like Open Office etc. office Convert Document To Image Free Office Convert Document To Image Free is another software in the list. It is a simple program which lets you convert Office documents including PowerPoint presentations into various common image
formats. You can convert PowerPoint file (PPT, PPTX, or PPTM) to JPG easily by using it. First you have to close all the instances of MS Office and then run this program, otherwise it will close them automatically. Now click “Add File” button from the File menu to add the PowerPoint file to its list. Now choose the desired file format from the “Output
File Type” tab (JPG in our case). Choose the Save Folder by browsing. You can set the output filename also, if required. Finally click Convert button to start the process. All the slides in the PowerPoint presentation you choose will be converted into separate JPG images in the output folder. Other image output formats it supports are: BMP, GIF, TIF,
TGA, RLE, PNG, EMF, and WMF. The program comes in other languages also and you can select the respective language from the Settings menu. It asks you to register the program when exiting, but you can just click on Close button and ignore the message.
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